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PROJECTWISE OVERVIEW

What is ProjectWise?

ProjectWise is a project collaboration and AECO information
management software developed explicitly for the design and
construction of architecture, engineering, construction, and
operations (AECO) of infrastructure projects.

ProjectWise (PW) is designed to house and organize all project related
documents, including but not limited to MicroStation design files,
Geopak files, all Microsoft Office documents, PDFs, text files,
images, etc. Users can store any document type within ProjectWise
and configure ProjectWise to launch a specific application for each
document type.

How is ProjectWise Beneficial to Users?

ProjectWise is collaboration software, therefore users have access to working project documents based on
their security privileges, even if they are off-site. Users will no longer have to extensively search for
documents or be concerned with the document being the most current version. ProjectWise has a robust
search engine which allows users to search by document attributes or key words within a file using the full-
text search capability.

Users will no longer have to be concerned with unauthorized access to their documents. ProjectWise is
configured to only allow individuals who have the appropriate security privileges to access documents.

Also, ProjectWise has an in-depth audit trail that tracks all activity within the system; to include logging in/out
of the system, checking document in/out, exporting/importing documents, viewing documents,
copying/deleting/modifying documents, and allows for customized audit reports.
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ELECTRONIC SUBMISSION AND RETRIEVAL GUIDE OBJECTIVE

SCDOT is currently using ProjectWise to manage electronic submission and retrieval of proposals, templates
and project documents from engineering firms and contractors. SCDOT's future goal is to fully utilize
ProjectWise to store and backup project documents, share data across project teams to include primary
consultants no matter where they are located, and provide SCDOT project managers with additional tools
to manage their engineering projects.

SCDOT looks forward to using the ProjectWise system to connect SCDOT employees, engineering firms and
transportation project information. ProjectWise technology will improve the quality of work, save all parties
time, help ensure project deadlines are met, and will reduce project cost.

SCLOoT QPROJECTS ONLINE

Objective

The objective of this document is to assist with the installation of the ProjectWise V8i Web Parts Client and to
demonstrate the SCDOT Professional Services, Design Build and Rights of Way Template electronic submittal
and retrieval process through the ProjectWise V8i Web Parts Client.

The ProjectWise V8i Web Parts Client allows a primary consultant to create, edit, check in/check out, and
delete documents within ProjectWise based on the user’s access privileges.

The ProjectWise V8i Web Parts Client is an internet based client that requires the use of Internet Explorer (IE)
8 or later (32-bit only). It also requires the installation of an Active X control for file transfers. ProjectWise can
also be used with iPad - Safari on iOS5.x*.

SCDOT ITS Engineering Technology & Research Office 2 ProjectWise Electronic Submission Guide
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PROJECTWISE V8| WEB PARTS CLIENT INSTALLATION

NOTE: Please make sure to have the ProjectWise Electronic Submission and Retrieval Guide available in either
electronic or hardcopy format to assist with configuring and logging onto the ProjectWise application for the
first time. Administrative privileges are required to install the Internet Explorer (IE) web browser ActiveX
control.

(1). Setting SCDOT’s site as a Trusted Site
The software this site utilizes is called ProjectWise by Bentley Systems. ProjectWise requires a trusted
site to provide an extra layer of security for end users. SCDOT can provide additional details if

requested.

a. Open the Internet Explorer (IE) web browser on your computer. (This application requires
Microsoft IE 8.0 or higher, 32-bit only to function properly)

1. Click on the ”"Tools” button from the (IE) command bar.

2. Then select “Internet Options” from the bottom of the dropdown menu.

[ . -
5 Reopen last browsing session

:| Pop-up Blocker r
Yiew downloads o Ctrl+J
= Manage add-ons J
ey Work offline

b

Compatibility View settings
#|  Full screen F11

Toolbars L4

Explorer bars »

<ly> F12 developer tools

Suggested Sites

{1 Internet options ’lhg—/
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b. The “Internet Options” dialog box will appear on the screen.
1. Select the “Security” tab from the Internet Options dialog box.
2. Click on the “Trusted sites” icon from the “Select a zone to view or change settings.”

3. Then click on the “Sites” button.

e

Internet Opticns lE'E'J l 2 Lﬁj

|

‘F v ontent | Cor J Programs | Aduan::ed|

Restricted
sites

Internet Local intrane

Trusted sites

This zone contains websites that you
trust not to damage your computer or
your files,

You have websites in this zone

Security level for this zone
Allowed levels for this zone: All

Medium
- Prompts before downloading potentially unsafe

[ content

- Unsigned ActiveX controls will not be downloaded

[T1Enable Protected Maode {requires restarting Internet Explorer)
Custom level. .. Default level

’ Reset all zones to default level ]

nﬁn Some settings are managed by your system administrator.

[ QK. ] [ Cancel Apply
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c. The “Trusted sites” dialog box will appear on the screen.

1. Enter “https://pw.scdot.org/” in the “Add this website to the zone:” field.

2. Then Click on the “Add” button after you enter the address from above.

rTI'LIStEd sites [EJ ﬁ"‘

You can add and remove websites f, ne. All websites in
S this zone will use the zone's securit i

=

Wehsites:

Remove

[¥] Require server verification (https:) for all sites in this zone

Close

d. The address you entered will be added to the “Websites:” area.

1. Click on “Close” to exit the dialog box.

IrTrusteu:l sites [EJ lﬁ‘

You can add and remove websites from this zone. All websites in
i this zone will use the zone's security settings.

Add this website to the zone:
add

Websites:

hitps:/ipw.=cdot_org/ = Remove

[#] Require server verification (https:) for all sites in this zone

O—=

L A
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(2). Accessing the ProjectWise V8i Web Parts Client for the First Time
a. Click on the address bar in the (IE) web browser.

1. Enter “https://pw.scdot.org/” into the address bar to access the ProjectWise V8i Web Parts
Client.

NOTE: Users may also want to bookmark this site as a favorite in (IE).

B https://pw.scdot.org/

ﬁvvjvpagev

hOt & - || &P ProjectWise Web Server

Safety v Tools = g~

b. The “ProjectWise Web Client” login dialog box will appear in the center of the web browser.

1. Make sure that “SCDOT” is selected from the “Location:” drop down menu.

PROJECTWISE
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c. Make sure to have the account login information that was provided to you by email from SCDOT
available in either electronic or hardcopy format to assist you in logging onto the ProjectWise
application.

1. Enter the user name and password provided into the “User Name:” and “Password:” fields.
2. Then click the “Login” button.

NOTE: Users can copy and paste the username and password from the account login
information email into the appropriate fields.

Location:
SCDOT

User Name:
Password:

PROJECTWISE
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d. When users login into the SCDOT ProjectWise V8i Web Parts Client Internet Application for the first
time, users will be prompted with the following “Internet Explorer — Security Warning” message.

1. Select “Always install software from Bentley Systems, Incorporated”
2. Then click on the “Install” button.

NOTE: Please make sure that your (IE) web browser is set to allow pop-up windows.

Internet Explorer - Security Warning [EJ ﬁ

Do you want to install this software?

@ Mame: ProjectWiseWebServerClientComponents.cab

Publisher: Bentley Systems, Incorporated
I 0' "Bentey Systems, Incorporated” 9}
"I Mever install softwa

! entley Systems, Incorporated” /
(7 Ask me every time
E] Fewer options Don't Insts

[ rl While files from the Internet can be useful, this file type can pu::tentlally harm
"%/ your computer. Only install software from publlshers you trust. What's the risk?

e. You are required to change your password used to logon into the SCDOT ProjectWise V8i Web
Parts Client Internet Application.

1. Click on the “Tools” button from the ProjectWise application’s menu bar.

2. Then click on “Change Password” from the bottom of the dropdown menu.

m i1 select all
@] Copy web link to this location

[0 1-Proposal Subi®a copy Projectise link to this location

L, 3 - In Negotiatiol

g Directory

S+—0)
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f. The “Change Password Dialog” box will appear on the screen.

1. Enter the same password used to log onto the application which was provided in the email
by SCDOT into the “Current password:” field.

2. Enter a new password into the “New password:” field.
3. Then enter the new password again into the “Repeat new password:” field.

4. Then click the “OK” button.

NOTE: Users are required to create a password that is at least 8 characters long with at least one
capital letter, one lower case letter, and either a number or special character.

Current password:

Mew password: lfp— )

Repeat new password: - '

g. A dialog box will appear stating that “Your password has successfully changed.”

V

1. Click on “OK” to complete changing the password and to start using the SCDOT ProjectWise
V8i Web Parts Client Internet Application.

J:}) Your password was successfully changed.

SCDOT ITS Engineering Technology & Research Office 9 ProjectWise Electronic Submission Guide
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PROFESSIONAL SERVICES ELECTRONIC SUBMISSION

(1). Document Naming Convention

Consultants are required to use the document naming convention below to name their Professional
Services documents before uploading them into the Professional Services Solicitations folder. The PIN

number is listed in the South Carolina Business Opportunities (SCBO) ad under the title of the
Professional Services solicitation.

Example: PIN_ConsultantName.extension (Example: S-XXX-SS_XYZ.pdf)
(2). Accessing the SCDOT ProjectWise Web Parts Client Website

a. Consultants will use the ProjectWise Web Parts Client to upload their documents by accessing
https://pw.scdot.org/.

NOTE: It is important to follow the ProjectWise V8i Web Parts Client Installation section’s
instructions first to configure ProjectWise so users will be able to utilize the system.

1. Make sure that “SCDOT” is selected from the “Location:” drop down menu.
2. Enter the user name and password into the “User Name:” and “Password:” fields.

3. Then click the “Login” button.

SCI%TCD

-

Location:
|
I

User Name:

Password:

@ [ |

PROJESTWISE
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b. Afterlogging into ProjectWise, “Documents” will appear on the top-left of the tree pane.

1. Expand the “Documents” folder from the navigation tree by clicking on the “+” sign beside

Expand the “~-CONSULTANTS” folder by clicking on the “+” sign beside the folder.

Expand the “1 — Consultant Proposals” folder by clicking on the “+” sign beside the folder.

r by clicking on the “+” sign beside the folder.

“S-XXX-SS”) by clicking on the “+” sign beside

Expand the “00 — Consultants” folder to see the consultant folder (Example: “XYZ”) by

the folder.
2.
3.
4. Expand the “1 —Proposal Submissions” folde
5. Expand the project (Example Project Name:
the project.
6.
clicking on the “+” sign beside the folder.
7. Select the consultant folder (Example: “XYZ”).

=" Documents e
@L CONSULTANTS =" J
@t; 1 - Proposal Submissions

@ 2 S300K-5S

@,‘, 00 - Consultan

) ﬁ Sawed Searches
# | -EXCHANGE

= @ Saved Searches

@t; 1 - Consultant Proposals ""

@ | Required Consultazs Certificatio

o o

©

0
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(3). Uploading a Document
a. With the consultant folder (Example: “XYZ”) selected, a document can be uploaded into the folder.
1. Click on the “Document” dropdown from the menu.

2. Then click the “Upload” option from the dropdown.

4=

SCLT QPROJECTS ONLINE =

Advanced Searc

ESMPPWINTd.nts.scd... #4 co_consultant Folder - Tools Help

= ' Documents

= [ -CONSULTANTS FI',-L‘@

= [ 1 - Consultant Proposals

= & 1 -Proposal Submissions 0‘
® | Required Consultant Certificatio
= B S006ss . )

= [ 00 - Consultants

B xvz

= @4 Saved Searches
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b. The “Select Files to Upload” dialog box will appear.
1. Navigate to the desired document and select it.
2. Click the “Open” button on the “Select Files to Upload” dialog box.

NOTE: Use the Document Naming Convention protocol described at the beginning of this
chapter.

Example: PIN_ConsultantName.extension (Example: S-XXX-SS_XYZ.pdf)

(2 Select Files to Upload I. (= J @

Look in: | | ProjectWise Docs j (< s A
1= . Date modified Type
"
= (w 1/13/2014 839 AM  Adobe Ac
Recent Places
Desktop 1{
Libraries J
. i
LY
Computer
i 2
Metwaorl: '
1| 1]
File name: | ﬂ
Files of type: | j

SCDOT ITS Engineering Technology & Research Office 13 ProjectWise Electronic Submission Guide



RETURN TO TABLE OF CONTENTS

c. Once the document upload process has completed, you can view the “content pane” to view your

document.

1. The document that has been uploaded appears in the “content pane” within ProjectWise.

2. Click “Logout” from the top right of the browser window to exit ProjectWise.

= [ = [ E ﬁ
e a https://pw.scdot.org/default.aspx?default=ECObject: © ~ & C & ProjectWise Web Server :
!
ﬁ B = @1 v Page~ Safety~ Tools 'ﬂ-' .
0Q0
»
= O O
ava 0
] d 0_C0 olae Do 00 p
= [ Documents A g I EL Default | WV =l Professional 5|W

2 & -CONSULTANTS

& 1 - Consultant Proposals

A/ SX00CSS XYZpdf | XvZ

1/23/2014 9:08:14 AM
= 1 - Proposal Submissions

@ [ Required Consultant Certificatio

7% 50058

= [ 00 - Consultants

T
1

& 4 saved Searches

g. You will receive a confirmation email after you upload is complete.

SCDOT Professional Services Submission Upload Receipt -

McAfee E-mail Scan Acrobat ProjectWise Q@ Tell me what you want to do...

E Team Email v Done H. Categorize ~
.,l& - Delete  Reply Reply Forward

= x ﬁ:\é E;\é E% 5‘;' ¥ Inbox Ef)ToManager ¥ =T % £2% Mark Unread % JD?v Q m @
[y«

© " - Move —_ Assi Translate Zoom  Sendto  Insights
Al E'E- « Reply & Delete ¥ Create New . Ep- Palicy > Follow Up . OneNote
Delete Respond Cuick Steps (] Move Tags ] Editing Zoom OneMNote -
NoReply@scdot.org 12/2/2012
SCDOT Professional Services Submission Upload Receipt - S-XXX-SS Test Project v
This is an automated email to notify you that the following F ional Services Submission - S-XXX-55_XYZ.pdf was uploaded to project 5-XXX-55 Test Project successfully by XYZ
within the SCDOT ProjectWise system.

Firm Name: XYZ

ProjectWise Link: -CONSULTANTS\1 - Consultant Proposals\] - Proposal Submissions\S-XXX-55 Test Project\00 - Consultants\XYZ\S-XXX-55 XYZ pdf
Uploaded Date and Time: December 2, 2019 @ 1:42 PM

Uploaded By: XYZ—lestuser@test.com
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DESIGN BUILD ELECTRONIC SUBMISSION

(1). Document Naming Convention

When uploading files to ProjectWise, it is critical that all files are named consistently. By using these
naming conventions SCDOT can maintain a uniform file structure in ProjectWise across all Design-Build
Projects. The Design-Build File Naming Conventions can be located here: Design Build Naming
Convention. The Project ID is listed in the South Carolina Business Opportunities (SCBO) ad under the
title of the Design Build solicitation and can also be found on the title page of the project’s Request for
Qualifications (RFQ) and the Request for Proposal (RFP).

(2). Accessing the SCDOT ProjectWise Web Parts Client Website

a. Consultants and contractors can use the ProjectWise Web Parts Client to upload their

documents by accessing https://pw.scdot.org/. If your firm uses ProjectWise Explorer, you can

add the SCDOT Datasource and use it for uploads. Please contact Matthew Boozer at

BoozerML@scdot.org or Judy Hite at HiteJT@scdot.org to receive a copy of the datasource

configuration instructions. ATC submittals require the use of ProjectWise Explorer. Please

contact Brooks Bickley at BickleyBJ@scdot.org for more information.

NOTE: It is important to follow the ProjectWise V8i Web Parts Client Installation section’s

instructions first to configure ProjectWise so users will be able to utilize the system.
1. Make sure that “SCDOT” is selected from the “Location:” drop down menu.
2. Enter the user name and password into the “User Name:” and “Password:” fields.

3. Then click the “Login” button.
I3

= PROJECTWISE
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b. After logging into ProjectWise, “Documents” will appear on the top-left of the tree pane.

1. Expand the “Documents” folder from the navigation tree by clicking on the “+” sign beside
the folder.

2. Expand the “-EXCHANGE” folder by clicking on the “+” sign beside the folder.
3. Then expand your company folder by clicking on the “+” sign beside the folder.

4. Select the “02 — Design Build” folder.

X B hitps://pw.scdot.org/ O - & ¢ || B ProjectWise Web Server

2 PROJECTS ONLINE

FOLDER DOCUMENT VIEW TOOLS

Name

01 Abbeville

02 Aiken

03 Allendale
04 Anderson
05 Bamberg
06 Barnwell
07 Beaufort
08 Berkeley
09 Calhoun
10 Charleston

11 Cherokee

Ooo0oo0ooooooQgaogaojg
|

12 Chester

e A https://pw.scdot.org/

rg‘; scOBT

O ' oecumens _o n

B [ | 01abbevile

B [ o2aiken

[+ -CONSULTANTS

@ | -EXCHANGE h e
— O 24 Greenwood
© Xvz

P [l 25 Hampton
01 Professional Services

26 Horry
-+ 02 Design Build h

77 lacner
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(3). Uploading a Document
a. With the “02 - Design Build” folder selected, a document can be uploaded into the folder.
1. Click on the “Document” dropdown from the menu.

2. Then click the “New” option from the dropdown.

.-t' PROJECTS ONLINFE

46 York

|
_ @
B2 | | 51District1
B | 52District2
| | 53District3
& | | 54Districta
& | | 55Districts
& | | 56Districts
B | | 57District7
[+ w— BB Statewide
& | | -ADMINISTRATIVE
B | | -CONSULTANTS
B | -EXCHANGE
B T vz

01 Professicnal Services

B ] 02Design Build

ATC
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b. The “New Document” dialog box will appear

1. Minimize the "Document" tab.

2. Under the “File” tab, select the “Browse...” button.

%L;‘) https://pw.scdot.org/TConnectionld=default&set_Currentkey=ECObjects... — O X
@) vt A— o
El File
e —
tach a e [e C__— W@
File Name | |
E] attributes
DESIGN BUILD SUBMITTALS
1. Click browse to attach a file.
2. Select appropriate the document type.
3. Select the appropriate project from Project menu.
CONSULTANT oz |
DOCUMENT TYPE: | |
PROJECT: | -
=u
#100% ~
SCDOT ITS Engineering Technology & Research Office 18
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c. The “Choose File to Upload” dialog box will appear.
1. Navigate to the desired document and select it. @

2. Click the “Open” button on the “Choose File to Upload” dialog box.

NOTE: Use the Design Build Naming Convention protocol.

2 Choose Filel/\e Upload X

S » ThisPC » Desktop » ProjectWise Docs v 0 Search ProjectWise Docs »

==~ W @

MName Date medified Type

RIMS-ITMS 12/2/201910:15AM _ Adobe Acrobat D...
2019

bin

Organize = Mew folder

| Pictures ~

ProjectWise Docs
PW Search Results

= This PC
[ Desktop o
g Documents
* Downloads

J‘! Music 9
&= Pictures
m Videos

=2 Windows (C)

LB 4

File name: | JCOO0KK_XYZ Il Files (*.*)

cance'
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d. The “DOCUMENT TYPE” attribute will help SCDOT identify the type of document.

1. Under the “Attributes” tab, click on the “DOCUMENT TYPE:” button and the “Select Value”
dialog box will appear.

2. From the “Select Value” dialog box, select the appropriate document type for the document
from the dropdown options.

3. Click “OK” on the “Select Value” dialog box.

Document

File
Attach a file | XXXXXXX_XYZ.pdf Browse...
File Name | YHXXXXX_XYZ.pdf

1. Click browse to attach a file.

DESIGN BUILD SUBMITTALS

2. Select appropriate the document type.

3. Select the appropriate project from Project menu.

CONSULTANT [xvz |

DOCUMENT TYPE: | o i@
PROJECT: |
Select value _

Contract Request . e
Design Submittals
Proposals

Questions
Statement of Qualifications

0 — (ERE=N
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e. The “Project” attribute will help SCDOT identify which project the document belongs to.

1. Under the “Attributes” tab, click on the “PROJECT:” button and the “Select Value” dialog

box will appear.

2. A. From the “Select Value” dialog box, select the appropriate project for the document
from the dropdown options (see "Example A").
B. If Project is not listed, click "Cancel" to close "Select Value" box. Manually type the

name in (see "Example B").

3. Click “OK” on the “Select Value” dialog box (Nothing to select in "Example B").

4. Click “Save” on the “New Document” dialog box.

EXAMPLE A
& hitps://pw.scdot.org/TConnectionld=defaultiset Currentkey=ECObjects.. — m] X
[Z] Document [s
E File
Attach a file | Browse..
File Name |

: lj Attributes ’

DESIGN BUILD SUBMITTALS

1. Click browse to attach a file
2. Select appropriate the document type.

3. Select the appropriate project from Preject menu

CONSULTANT [xz |

DOCUMENT TYPE: | Questions 5|

PROJECT: M

Select value x

| Vit &)

EDE=m
9/

I 0012506 - I-26 over SC 302t (DB)

0 — =

H00% -

EXAMPLE B

L\\:é;' https://pw.scdot.org/?Connectionld=default&iset_Currentey=ECObjects.. — m] *

D Document

B File

Attach a file | Browse.___

File Name |

D Attributes

DESIGN BUILD SUBMITTALS

1. Click browse to attach a file
2. Select appropriate the document type.

3. Select the appropriate project from Project menu.

CONSULTANT [z |

DOCUMENT TYPE: | Questions |

PROJECT:
Select value 2
0012506 - I-26 over SC 302t (DB) j

CONSULTANT [z

DOCUMENT TYPE: | Guestions

PROJECT: | PODD0D0 Test Project X|L=]

€ [osers
O > EERE=R

SCDOT ITS Engineering Technology & Research Office
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f. Once the document upload process has completed, you can view the “content pane” to view
your document.

1. The document that has been uploaded appears in the “content pane” within ProjectWise.

2. Click “Logout” from the top right of the browser window to exit ProjectWise.

B https://pw.scdot.org/default.aspildefault=ECObjects%7cBentley_ DM TcDI‘-ﬁIEF:\cIE\‘:.'c1§4£:'i pP-ac

@ scdot.org 5 ProjectWise Web Server

s, PROJECTS ONLINE

Advanced search options

DOCUMENT
B 5 oz

e 3@

C 01 Professional Se

. O Name CONSULTANT NAME: PROJECT: DI

E | 02 Design Build
_ [0 | | oratc
ATC
O | A / HHKXHXX_KVZ pf xwz PO000C TEST PROJECT | Questiol

¥

g. You will receive a confirmation email after you upload is complete.

SCDOT Design Build Submission Upload Receipt - TEST - Message (HTML)

McAfee E-mail Scan Acrobat ProjectWise Q Tell me what you want to do...

= x ﬁ_@ (ﬁ% ﬁ% g‘gv ¥ Inbox %goo:d:nager ¥ =T E 3% Mark Unread % pv q m \—:))

e R p EJ Team Email - e H Categorize = ol B = St sl
- Delete eply Reply Forwar _ ove ssign ranslate oom end to nsights
& Al Ey- & Reply & Delete F Create New M . B~ Policy - [* Follow Up~ . [y - OneNote
Delete Respond Quick Steps (F] Move Tags ] Editing Zoom OneMote M
NoReply@scdot.org

Mon 10:19 AM

SCDOT Design Build Submission Upload Receipt - TEST
6Y0u replied to this message on 12/2/2019 10:23 AM.

This is an automated email to notify you that the following Questions - TEST DOCUMENT.docx was uploaded to project TEST successfully by XYZ within the SCDOT
ProjectWise system.

Firm Name: XYZ

ProjectWise Link: -EXCHANGE\XY7\02 Design Builld TEST DOCUMENT docx
Uploaded Date and Time: December 2, 2019 @ 10:19 AM
Uploaded By: xyZ
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RIGHTS OF WAY TEMPLATES ELECTRONIC RETRIEVAL

(1). Accessing the SCDOT ProjectWise Web Parts Client Website

a. Rights of Way firms will use the ProjectWise Web Parts Client to retrieve Rights of Way Templates
by accessing https://pw.scdot.org/.

NOTE: It is important to follow the ProjectWise V8i Web Parts Client Installation section’s
instructions first to configure ProjectWise so users will be able to utilize the system.

1. Make sure that “SCDOT” is selected from the “Location:” drop down menu.
2. Enter the user name and password into the “User Name:” and “Password:” fields.

3. Then click the “Login” button.

Location:

SCLST ©

User Name:

Password:

@ =

PROJEETWISE
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b. Afterlogging into ProjectWise, “Documents” will appear on the top-left of the tree pane.

1. Expand the “Documents” folder from the navigation tree by clicking on the “+” sign beside
the folder.

2. Expand the “-GENERAL FILES” folder by clicking on the “+” sign beside the folder.
3. Then expand the “ROW Templates” folder by clicking on the “+” sign beside the folder to

select the desired template folder and the document(s) will appear in the ProjectWise
“content pane” for the folder you selected.

scest SPPrRoJECTS O

SMPPWINT4.nts.scdo...  #3% co_consultant

@4 Safed Searches

SC T €'-}PROJ ECITS O

I SMPPWINT4.nts.scdo... # gnsultant

@[; Documents i
(© [ -GENERAL FILES 1—.....__9
QT D, =

[ Acquisition e

0 Appraisal _)

L ClaimPay

|0 Condemnation

L Help

L0 Miscellaneous

[; Property Management
| Railroads

[ Relocation

i scoot

[0 utilities

@ Saved Searches
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(2). Retrieving and Saving a Template

a. With the “ROW Templates” expanded and the desired subfolder selected, a template can be
opened within Microsoft Word or Excel.

1. Single click on the desired template from the ProjectWise “content pane.”

AR https://pw.scdot.org/default.aspx?default=ECObjects O ~ @& C || ProjectWise Web Server

v Page= Safety~ Tools~ I@Iv

SCoT QPROJ ECTS ONLINE

& SMPPWINT4.nts.scdo... #3 co_consultant Folder Document Tools Help

Advanced Search

= & Documents Interface: VIV ROW Template v
& 7 -GENERAL FILES DOCUMENT TYPE: Updated
= I ROW Templates -
[17] 801 Easement.dot — ) Acquisition 11/12/2013 9:30:05 AM Stuc
[ Acguisition
e o — P . -
[ Appraisal [w] [] 201EXHI Easement.dat Acguisition 11/12/2013 11:49:07 AM | Stuc
[ cClaimPay {w] [] 202 Title to Real Estate.dot Acquisition 11/12/2013 11:49:14 AM | Stuc
[ Condemnation )
@ L:J 802EXHI Title to Real Estate.dot Acquisition 11/12/2013 11:49:22 AM | Stuc
[ Help
[ Miscellaneous @ U 803 Permission.dot Acquisition 11/12/2013 9:30:17 AM Stuc
[ Property Management [w] [] 204 Quitclaim dot Acqguisition 11/12/2013 9:30:28 AM | Stuc
[ Railroads R )
(w] [ 805 Easement for Counties.dot Acquisition 11/12/2013 11:49:35 AM | Stuc
[ Relocation
[ scoot [w] [ 806 Permission for Counties.dot Acquisition 11/12/2013 11:49:45 AM | Stuc
[ utilities [w] [ 207 Muni State Hwy Proj Agree.dot Acquisition 11/12/2013 11:49:52 AM | Stuc
@4 Saved Searches . _ ]
[w] [] 208 Payment for Right of Way.dot Acquisition 11/12/2013 11:49:56 AM | Stuc
(w] [ 809 ROW Worksheet.dot Acquisition 11/12/2013 11:50:01 AM | Stuc
[w] [ 809EX ROW Worksheet-Page 2 dot Acquisition 11/12/2013 11:50:07 AM | Stuc
[w] [ 211 Real Property Agreement.dot Acguisition 11/12/2013 11:50:12 AM | Stuc
W
feel [ 817 €M Infasmnatinm dar Bom s i 131 /1A NI 1. rAT T A [T
< >
https://pw.scdot.org/default.aspxidefault=ECObjects%7 cBentley_DMS3:7 cDMSDocument?a7 c1904...
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b. The “Windows Internet Explorer” dialog box will appear.

1. Single click the last option “Save as.”

-

Windows Internet Explorer @J Iﬁ

What do you want to do with 801 Easement.dot?

Size: 263 KB
From: pw.scdot.org

= Open

The file won't be saved automatically.

=+ Save

ha L

Cancel

c. The “Save As” dialog box will appear.
1. Navigate to the desired folder and select it.

2. Click the “Save” button on the “Save As” dialog box.

r-@ Save As [EJ @1
@-\;J-v| . v Libraries » Documents » My Documents » ProjectWise Docs - | 3 | | Search ProjectWise Docs ol
Organize « MNew folder = - .@.

T *  Documents library

- n Arrange by:  Folder =
ProjectWise Docs

0| : Date modified Type Size

Mo items match your search.

> k=] Pictures
> B8 Videos

> ¥ Homegroup

4 1M Computer
> &, 05(C)

S [N PR i T 1

File name: 801 Easement.dot

Save as type: | Microsoft Word 97 - 2003 Template (*.dot)

= Hide Folders

9}—. Save Cancel
\
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d. Adialog box will appear at the bottom of the browser.

1. Select “Open” to open the saved document or the file can be opened at a later time by
navigating to the folder where it was saved.

The 801 Easement.dot download has completed. OH Open folder View downloads
-
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